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This software operates under the Microsoft Windows 95, 98 and NT operating systems.
This manual references only these Microsoft Windows Operating Systems and compatible
Mouse devices. For details please refer to the Microsoft Windows operation manual.
Various terms are used in this operation manual.
If there are any terms in the manual you do not understand, please refer to “Glossary”
(page 68).

Note that Sharp Advanced Presentation Software Professional Edition is subject to
change without prior notice for upgrading and improvement.
The latest information on this software can be found at the following web site:
http://www.sharp-world.com/projector

� Microsoft and Windows are registered trademarks of Microsoft Corporation, USA.
� All other brand or product names are trademarks or registered trademarks of

their respective holders.
� Great effort has been expended to ensure that the descriptions in this manual

are correct. Should you, however, come across an inconsistency, a telephone
call or letter to SHARP Corporation noting the questionable area would be highly
appreciated.

� This software is the property of SHARP Corporation and all related copyright and
other rights belong to SHARP Corporation.

� This manual may not be transferred wholly or in part in any form whatsoever
without prior written permission. Uses other than personal use are for copyright
reasons not permitted without the written permission of SHARP Corporation.

� SHARP Corporation shall in no event be liable for damages, loss of revenue or
third party claims arising from the use of the software.

� Software specifications and the contents of the operation manual are subject to
change without prior notice.

� Operating speed may slow down depending on computer operating environment
and processing capability.

� The software is based on modules developed by the Independent JPEG Group.
� The software uses LEAD Tools Pro developed by Bunka Orient Corp. and Lead

Technologies, Inc.
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Foreword

This software is designed for presentations and for enhancement of
images projected from SHARP LCD projectors. It includes the following
functions:

Projector Control Software:
Network Control
This function allows you to control the projector’s functions/
adjustments from your PC.
At maximum 250 projectors or grouped projectors can be controlled
from a central PC/CONTROLLER.
The Video Wall function, expensive device required normally, can
be performed without purchasing additional hardware.

Image Enhancement Software:
Gamma Correction
This function allows you to set the projector’s Gamma values directly
from your PC. The ease of specifying preset values enables very
precise custom brightness, contrast and colour adjustments.
Please note that this function can only be performed via the Network
(COM and LAN port).

Support Software for Presentations:
Presentation Transfer
This mode transmits BMP and JPEG images to a projector. By saving
presentation slides as BMP or JPEG images you can do an entire
presentation wirelessly.

Capture & Transfer
This mode allows you to transmit an image of what is currently
displayed on your monitor. This is as simple as pressing the “Capture
& Transfer” button in the application.

Quick Transfer
This mode is similar to “Capture & Transfer” but it can be used easily
by clicking the “Right” mouse button.

� Wireless image transfer can only be used with the XG-NV5/6/7.
Wireless image transfer cannot be used to transfer images with
other models.

� The XG-V10W does not support JPEG image transfer.
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If you want to project your presentation slides saved as BMP or JPEG
files...

Presentation Transfer transfers images quickly &
easily in presentation format. (See page 56)

For Your Reference

There are five functions via the Network (COM and LAN port).

If you want to adjust image colours on the screen...

Gamma Correction controls the image colours via the
Network (COM and LAN port). (See page 51)

If you want to control the projector adjustments from your PC...

Network Control controls the projector adjustments
via the Network (COM and LAN port). (See page 23)
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If you want to project an image of what is currently displayed on your monitor...

Capture & Transfer captures the image on the PC
monitor and transfers it to the projector. (See page 60)

If you want to project a single image quickly...

Quick Transfer captures the image on the PC monitor
and transfers it to the projector using the mouse as a
shortcut. (See page 62)



5

Contents

Foreword ....................................................................................... 2
For your reference ........................................................................ 3
Contents ........................................................................................ 5

Installing/Uninstalling
Required Hardware and Software ............................................... 7
Projector and PC Connections .................................................... 8

Connecting Multiple Projectors with PC .................................... 8
Connecting Single Projector with PC ........................................ 9

Installing the Software ............................................................... 10
Setting up your PC for Infrared Communications (IrCOM) ..... 14
Uninstalling the Software .......................................................... 17

Operations
Starting and Quitting .................................................................. 19

Opening Modes ....................................................................... 19
Starting from the “Sharp Advanced Presentation Software
Professional Edition” icon in the Windows task tray ........... 19
Starting from the Windows “Start” button ........................... 19
Starting from the “Sharp Advanced Presentation Software
Professional Edition” shortcut icon on the Windows
desktop ............................................................................... 20

Selecting the Operation Mode ................................................ 20
Changing Auto-Launch Setting ............................................... 21

When “Auto-Launch ON” is selected .................................. 21
When “Auto-Launch OFF” is selected ................................ 21

Selecting the mode ................................................................. 21
Quitting .................................................................................... 22
Help ......................................................................................... 22

Setup for controlling the projectors ......................................... 23
Scan Setting ............................................................................ 23

Deleting the set IP address ................................................ 24
Projector Setting ..................................................................... 25

Multiple Projector Operation Mode (Use ID Number) ......... 25
Multiple Projector Operation Mode (Don’t Use ID Number) ... 26
Single Projector Operation Mode ....................................... 27

Controlling the Multiple Projectors ........................................... 28
Multiple Control ....................................................................... 28
Group Setting .......................................................................... 30

To remove projectors belonging to groups from the group ... 31
To clear all the projectors belonging to group ..................... 31

Password Setting ....................................................................... 32
Setting the Password .............................................................. 32
Changing the Password .......................................................... 33

Selecting the Keylock Level ...................................................... 34
Projector Name and Unique Name setting ............................... 35
E-mail sending function ............................................................. 36

Mail Address Book setting ....................................................... 36
Send Mail Setting .................................................................... 36



6

Mail Send Timing ................................................................ 37
About the “Condition” check box ........................................ 37

Error notification function ......................................................... 38
Projector Timer Control ............................................................. 39
Controlling the Projector’s Adjustment .................................... 40

Network Control ...................................................................... 40
“Set Up” Adjustment ................................................................ 42
“Input1/2/3/4/5/6 PICT” Adjustment ......................................... 43
“Fine Sync” Adjustment ........................................................... 44
“Audio” Adjustment .................................................................. 45
“Options” Adjustment .............................................................. 46

Save Control Setting and Load Control Setting ...................... 48
To make “Save Control Setting” ......................................... 48
To make “Load Control Setting” .......................................... 48

Video Wall Setting ...................................................................... 49
To reset the current assignment settings ............................ 50
Projector image assignment with the Video Wall Setting ... 50

Adjusting Images ........................................................................ 51
Gamma Correction .................................................................. 51
Adjusting the GAMMA curve ................................................... 53

Setting the gamma correction area .................................... 53
Saving the gamma correction settings .................................... 54
Loading the gamma correction settings .................................. 54

Setup for Transferring Images .................................................. 55
Changing Compression Rate .................................................. 55

Transferring Images ................................................................... 56
Presentation Transfer .............................................................. 56

To send a single image (“Send Image”) ............................. 58
To send all the images (“Self Run”) .................................... 59

Capture & Transfer .................................................................. 60
To send another image ....................................................... 61

Quick Transfer ......................................................................... 62
To send another image ....................................................... 62

Saving a Custom Image as Startup Image and Background
Image ........................................................................................... 63

Appendix
Troubleshooting ......................................................................... 64

Unable to transfer images or an error occurs with
communication ........................................................................ 64

In case of cable communications (RS-232C and LAN) ...... 64
In case of infrared communications (IrCOM) ...................... 64

“Gamma Correction”/“Network Control” is not operating
properly ................................................................................... 65
The transmitting speed is low ................................................. 65
If 4 Mbps IrDA should fail ........................................................ 65
Unable to save the startup image ........................................... 66
Quality of the image is low ...................................................... 66
Unable to speed up the transfer or improve the image quality .... 66
Unable to speed up “Gamma Correction” though the
transmitting speed was changed ............................................ 66

Table of Functions by Model ..................................................... 67
Glossary ...................................................................................... 68
Services ....................................................................................... 70



7

In
stallin

g
/

U
n

in
stallin

g

Required Hardware and Software

Sharp Advanced Presentation Software Professional Edition
requires the following hardware and software for operation.

PC running under Microsoft Windows 95/98 or Windows NT
CPU 233 MHz Pentium or higher is recommended.

Display A 800 × 600 dot display capable of displaying
65,536 colours or more

Memory 32 MB or more

Hard disk free space 80 MB or more

Interface An available RS-232C serial port for transferring
images and controlling the projector

CD-ROM drive

Note that this software may not operate normally if the serial port settings,
etc., are not correct when serial equipment other than projectors is also
connected to the computer.

Using infrared communications (IrCOM)
If you use the NV-5/6/7, transferring images can be performed using
infrared communications (IrCOM). The PC requires a built-in infrared
communications port or an external infrared communications adapter.

� For Windows 95 users:
Microsoft IrDA 2.0 (Infrared Driver) has to be installed on your
PC to use this software. If it is not installed, you can obtain it
from the Microsoft’s site on the Internet.

� For Windows 98 users:
Microsoft Windows 98 supports IrDA communications as a
default programme.
Please consult to Microsoft operation manual for more details.

� For Windows NT users:
Infrared communications (IrCOM) cannot be used.

� The transmission speed of infrared communications is
dependent on the IrDA version of the PC.

• IrDA 1.0 : 9,600 bps - 115.2 kbps
• IrDA 1.1 : 4 Mbps

Therefore the actual speed depends on the IrDA version your PC
supports.
See the computer’s instruction manual for the IrDA specifications.

We cannot guarantee that the software will operate on computers whose
motherboards have been changed or modified, or on computers that
the users have configured themselves.
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Projector and PC Connections

This software requires the use of RS-232C serial cable or LAN cable or
infrared communications. For details on PC connections, refer to the
projector’s operation manual.

CAUTION
Before connecting, be sure to turn both the projector and the computer
off. After making all connections, turn the projector on first. The computer
should always be turned on last.

� Please read the computer’s instruction manual carefully.
� If you use the NV-5/6/7, image transfer by using infrared

communications can be available.

Connecting Multiple Projectors with PC

When connecting multiple projectors using ID numbers
(when forming a network system consisting only of XG-
V10Ws)

PC 3F

2F

1F

B1

OUT

OUT

OUT

IN

IN

IN

IN

IN

OUT

IN

� The connection between PC and the Projector or the Projector and
the Projector is possible by using projector’s RS-232C IN/OUT
terminal.

� Up to 250 projectors can be connected.
� Up to 10 COM ports can be used.
� Daisy chain connections are possible.
� LAN connections are possible (when using the optional extension

board (AN-L10T)).
� See “Table of Functions by Model” (page 67) about Projector’s

available function.
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When connecting multiple projectors without using ID
numbers (When forming a network including projectors other
than the XG-V10W)

PC
3F

2F

1F

IN

IN

IN

� Up to 10 projectors can be connected.
� Up to 10 COM ports can be used.
� Daisy chain connections are not possible.
� LAN connections are not possible.
� See “Table of Functions by Model” (page 67) about Projector’s

available function.

Connect one projector per COM port.
If you want to use the connection via the COM ports, the same number
of COM ports as the projectors are needed. If the numbers of COM
ports built in your PC is shorter than the numbers of projectors, purchase
the extension board (commercially available) to add the COM port to
your PC.

Connecting Single Projector with PC

RS-232C connection

Optional RS-232C cable(cross type)

Refer to the
projector’s operation
manual for details.
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Installing the Software

This software can be installed using the installation programme supplied
on the “Sharp Advanced Presentation Software Professional Edition
CD-ROM”.

1 Check that this software is suited for your computer.
For details, refer to “Required Hardware and Software” (page 7).

2 Quit all running applications before installing this
software.
Be sure to quit all other applications so that no problems occur with
the installer.

3 Delete the previous version of the Sharp Advanced
Presentation Software.
For details, refer to “Uninstalling the Software” (page 17).

4 Insert the “Sharp Advanced Presentation Software
Professional Edition CD-ROM” in the CD-ROM drive.

5 Double click the “My Computer” icon.

6 Double click the CD-ROM drive icon.

7 Double click the “saps_pro” folder.

8 Double click the “Setup.exe” icon.
w The “Sharp Advanced Presentation Software Professional

Edition Opening Image” will be displayed.
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w The “Sharp Advanced Presentation Software Professional
Edition” dialogue box will open.

9 Click “Next>”.
w The “Choose Destination Location” dialogue box will open.

10 The folder under which the software will be installed is
displayed in “Destination Folder”.

To select another folder, click “Browse...”.
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11 Click “Next>”.
w “Auto-Launch Setup” dialogue box will open.

12 Click “ON” under “Auto-Launch” to automatically launch
the software every time you start your PC. (Recommended)

If you set “Auto-Launch ON”, a “Sharp Advanced Presentation
Software Professional Edition” icon will reside in the Windows
task tray. If not, use the “Sharp Advanced Presentation
Software Professional Edition” shortcut icon on the desktop or
the Windows “Start” menu.

13 Click “Install>”.
w Installation will start.
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w When the installation is completed, the “Setup Complete”
dialogue box will open. To use the programme immediately,
please restart your computer.

14 Click “Finish”.
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Setting up your PC for Infrared Communications (IrCOM)

If you use the NV-5/6/7, image transfer can be performed using infrared
communications (IrCOM).
To use infrared communications, set the PC’s port for infrared
communications according to the following steps.

Infrared communications (IrCOM) cannot be used with Windows NT.

1 Click “Start”, and then click “Settings”, then select
“Control Panel”.
w The “Control Panel” window will open.

2 Double click the “Infrared Monitor” icon.

w The “Infrared Monitor” window will open.

For Windows 95 users:
If an “Infrared Monitor” icon is not displayed, a Microsoft IrDA 2.0
(Infrared Driver) is not installed on the computer.
You can obtain it from the Microsoft’s site on the Internet.
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3 Click the “Options” tab.
w The “Options” sheet will open.

4 Check the “Enable infrared communication” check box.
Select the port used for infrared communications.

Refer to the PC’s instruction manual for the appropriate port settings.
Do not check the “Search for and provide status for devices within
range” and “Limit connection speed to” check box.
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5 Click the “Preferences” tab.
w The “Preferences” sheet will open.

6 Click “Restore Defaults”.
The system will return to standard settings.

7 Click “OK”.
w The “Infrared Monitor” window will close and the “Infrared

Monitor” icon will appear in the Windows task tray.

Infrared Monitor icon

About the “Infrared Monitor” icon

 Enable: Ready to transfer

 Disable: Not ready to transfer
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Uninstalling the Software

Always uninstall Sharp Advanced Presentation Software Professional
Edition, when installing a new or updated version.

Before Uninstallation
� Software uninstallation can not be done when Sharp Advanced

Presentation Software Professional Edition is running.
Please make sure that the software is closed before proceeding.

� Before uninstalling Sharp Advanced Presentation Software
Professional Edition, the “Auto-Launch” setting must be “OFF”.
1) Double click the “Sharp Advanced Presentation Software

Professional Edition” icon.
2) Click the “Option” menu, select “Auto-Launch ON/OFF”.
3) Select “OFF”.
4) Close Sharp Advanced Presentation Software Professional

Edition.

1 Click “Start”, and then click “Settings”, then select
“Control Panel”.

2 Double click the “Add/Remove Programs” icon.

3 Click the “Sharp Advanced Presentation Software
Professional Edition”.
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4 Click the “Add/Remove...”.

5 Click the “Yes”.

6 When uninstallation is correctly completed, “Uninstall
successfully completed” message will appear. Click “OK”.
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Starting and Quitting

Opening Modes

Before starting the software, make sure that the projector and the PC
are correctly setup (page 8). There are three ways to start up the software.

Starting from the “Sharp Advanced Presentation Software
Professional Edition” icon in the Windows task tray

This icon appears when “Auto-Launch ON” is selected. See page 21
for “Auto-Launch” setting.

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turn on last.

The projector must be in IrCOM mode to receive the images. Press
the “IrCOM” button on the projector or the remote control.
For NV5/6/7 users:
To use infrared communications, select the “IrCOM” mode, referring
to the projector operation manual for details.

2 Start up the PC. Click the “Sharp Advanced Presentation
Software Professional Edition” icon in the Windows task
tray.
w The “Sharp Advanced Presentation Software Professional

Edition” window will open.

Starting from the Windows “Start” button

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turn on last.

The projector must be in IrCOM mode to receive the images. Press
the “IrCOM” button on the projector or the remote control.
For NV5/6/7 users:
To use infrared communications, select the “IrCOM” mode, referring
to the projector operation manual for details.
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2 Start up the PC. Click the “Start” button, set the pointer
to “Programs” and then “Sharp Advanced Presentation
Software Professional Edition”.
w The mode dialogue box will open.

Starting from the “Sharp Advanced Presentation Software
Professional Edition” shortcut icon on the Windows desktop

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turn on last.

The projector must be in IrCOM mode to receive the images. Press
the “IrCOM” button on the projector or the remote control.
For NV5/6/7 users:
To use infrared communications, select the “IrCOM” mode, referring
to the projector operation manual for details.

2 Double click the “Sharp Advanced Presentation Software
Professional Edition” shortcut icon on the Windows
desktop.
w The mode dialogue box will open.

Selecting the Operation Mode

1 Select “Operation Mode Setting...” from the “File” menu.

2 Select the Operation Mode.
� To operate a single projector, select “Single Projector Operation

Mode”
� To operate multiple projectors, select “Multiple Projector Operation

Mode”, then choose “Use ID Number” or “Don’t Use ID Number”.

� When “Don’t Use ID Number” is selected for “Multiple Projector
Operation Mode”, up to 10 projectors can be operated at once. Model
other than the XG-V10W can be used.

� When “Use ID Number” is selected for “Multiple Projector Operation
Mode”, up to 250 projectors can be operated at once. When using
“Use ID Number”, models other than the XG-V10W cannot be used.
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Changing Auto-Launch Setting

The default “Auto-Launch” setting is “ON”, which launches this
software automatically when the PC starts up. You can change the setting
as follows.

1 Click the “Option” menu, select “Auto-Launch ON/OFF”.

2 Select the setting as required.

When “Auto-Launch ON” is selected
� The “Sharp Advanced Presentation Software Professional

Edition” icon is resident in the Windows task tray.
� The software is automatically launched when the PC starts up.

When “Auto-Launch OFF” is selected
� The “Sharp Advanced Presentation Software Professional

Edition” icon is removed from the Windows task tray.
� In this case the software must be started from the “Start” menu or

the “Sharp Advanced Presentation Software Professional
Edition” shortcut icon on the Windows desktop.

Selecting the mode

1 Start up the projector.

2 Select the mode you require from the “Mode” menu. Or
you can use the shortcut buttons below the menu bar.

Gamma
Correction

Single
Control

Presentation
Transfer

Capture &
Transfer

Multiple
Control

Video Wall
Setting

w The mode dialogue box will open.
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Quitting

Click the “File” menu, and select “Exit”.
Or you can use the  button.

Help

To view Help, click the “Help” menu. When the “Help” window opens,
click the desired item in the Help list.

To check the software version, select “About This Software...” from
the “Help” menu.
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Setup for controlling the projectors

The settings for the projectors must first be made to the software before
attempting to control any projector. Settings are made at “Scan Setting”
or at “Projector Setting”.
To control multiple projectors using the projectors’ ID numbers:
Normally the settings are made at “Scan Setting”, but the same settings
can also be made at “Projector Setting”.
To control individual or multiple projectors without using the projectors’
ID numbers: Make the settings at “Projector Setting”.

The settings for the ID numbers on the projector is needed to control the
projector by using the ID numbers.

Scan Setting

This is a function by which this software automatically identifies and
controls all the projectors connected to the PC without setting the ports
and models. To use this function, the COM ports and IP address to be
scanned with “Scan Setting” must be set beforehand.
See below about Scan Setting.

1 Select “Scan Setting...” from the “File” menu.
Set the projector to be scanned here.

1 COM port enable/disable check box
2 Set the COM port Transmission Speed.
3 IP address input area

1

8

5 6

0

9

7

2

3

4
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4 List of input IP addresses and enable/disable check box
5 Add button

When clicked after inputting the IP address, the address is
added to the list in 4.

6 Delete button
When clicked after selecting the IP address in 4, that address
is deleted.

7 List of projectors whose IDs are redundant.
8 List of projectors whose IDs are missing.
9 Scan button
0 Close button

2 Set the port to which the projector is connected.
� At 1, Check the check box of the COM port to which the projector

is connected.
� To use a LAN, input the IP address at 3, click the “Add” button,

then check the check box at 4.

3 Click the “Scan” button.

Deleting the set IP address

1 Select the IP address to be deleted at 44444.

2 Click the “Delete” button.

LAN connections are possible when using the optional extension board
(AN-L10T).
The AN-L10T is scheduled for release in the near future.
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Projector Setting

When “Multiple Projector Operation Mode (Use ID Number)” is selected
at “Operation Mode Setting”, it is possible to add projectors manually
without using the scan setting automatic identification function. In
addition, when “Multiple Projector Operation Mode (Don’t Use ID
Number)” or “Single Projector Operation Mode” is selected, make the
respective settings at “Projector Setting”.

Multiple Projector Operation Mode (Use ID Number)

1 From the “File” menu, select “Projector Setting”.

1 Select the ID number.
2 Select the port.
3 Select the transmission speed.
4 Input the IP address.
5 Enable/disable check box
6 Select the projector model.
7 Apply button

2 Select the ID number.

3 Select the port to which the projector is connected.

If “LAN” is selected here, input the projector’s IP address.

4 Select the speed of transmission between the computer
and the projector.

� Set the transmission speed set here and the transmission speed on
the projector to the same speed.

� For instructions on the projector’s transmission speed setting, refer
to the projector’s operation manual.
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5 Select the projector model and check the “Use Projector”
check box.

6 Click the “Apply” button.

Multiple Projector Operation Mode (Don’t Use ID Number)

1 From the “File” menu, select “Projector Setting”.

2 Select the port to which the projector is connected.

3 Select the speed of transmission between the computer
and the projector.

� Set the transmission speed set here and the transmission speed on
the projector to the same speed.

� For instructions on the projector’s transmission speed setting, refer
to the projector’s operation manual.

4 Select the projector model and check the “Use Projector”
check box.

5 Click the “Apply” button.



27

A
d

ju
stin

g
 an

d
C

o
n

tro
llin

g

Single Projector Operation Mode

1 From the “File” menu, select “Projector Setting”.

1 Select the connection type.
2 Select the port.
3 Select the transmission speed.
4 Select the projector model.

2 Select the connection type.

3 Select the port to which the projector is connected.

4 Select the speed of transmission between the computer
and the projector.

� Set the transmission speed set here and the transmission speed on
the projector to the same speed.

� For instructions on the projector’s transmission speed setting, refer
to the projector’s operation manual.

5 Select the projector model.

6 Click the “OK” button.

4

2

31
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Controlling the Multiple Projectors

Multiple Control

This is a function for controlling multiple connected projectors (see page
8) from your computer. Depending on the connections, up to 250
projectors can be controlled.

1 Repeat steps 1-2 on “Selecting the Operation Mode” (page
20).

2 Select “Multiple Control” from the “Mode” menu or click
the  icon on the menu bar.
w The Multiple Operation Panel opens.

All projector: Section for controlling all the connected projectors.

1 Select the Power ON/OFF
2 Select “AV Mute” ON/OFF

The mute and black screen functions are conducted
simultaneously.

3 To make “Black Screen” ON/OFF
4 Select “Mute” ON/OFF

CAUTION
If the power of all the projectors is turned on at once, the power capacity
in the facilities may be exceeded. To avoid this, this software is equipped
with a function for making a setting for turning on the power of the
projectors one at a time.

7
8
9
0

q

r

t
y

5
6

1 2
3
4

w
e
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1 From the “Control Option” menu, select “Configuration”.

2 Select “ALL” if you want to power of all the projectors to
turn on at once, “Delayed” if you want the projectors to
turn on one at a time in order.

3 Click the “OK” button.

Group Projector: This is a section for controlling grouped projectors
one group at a time. The adjustment items in this
frame are reflected for all the projectors in the
selected group.

5 Select the Power ON/OFF
6 Select the “Input Mode” from RGB1 to 3, or Video 1 to 3.
7 To make “Volume“ adjustment.

The volume of the projector with the lowest ID number in the group
is displayed.

8 Select “AV Mute” ON/OFF
9 To make “Black Screen”
0 Select “Mute” ON/OFF
q Group List

Displays a list of all the connected groups.
w Updates the display to the most recent information.
e Jumps to the detailed settings for the group or for the individual

projectors. (For a description of the detailed settings, see page
40.)

All Projector List: This is a section for a list of all the identifiable
connected projectors.

r Projector List:
Displays a list of all the identifiable connected projectors.

t Updates the display to the most recent information.
y Jumps to the detailed settings for the group or for the individual

projectors. (For a description of the detailed settings, see page
40.)

Some items may not be displayed, depending on the type of projector.
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Group Setting

Individual projectors not belonging to groups can be added to groups,
and projectors belonging to groups can be removed from groups.

This function can only be available in the “Multiple Projector Operation
Mode (Use ID Number)”.

1 Select “Group Setting...” from the “Control Option” menu.
w The “Group Setting” window will open.

1 List of connected projectors
2 Select Group No.
3 Input Group Name.
4 List of projectors belonging to groups
5 Right arrow

Adds the projector selected in the list of connected projectors
to the group.

6 Left arrow
Removes the projector selected in the list of projectors
belonging to the group from the group.

7 Clear all the projectors belonging to the selected group.
8 Applies the setting.
9 Cancels the setting.

2 Select the group to be registered in the Group Number
and Group Name input column.

3 Select the projector in the list of connected projectors.

4 Click the right arrow button.
The selected projector is displayed in the list of projectors to which
groups also belong.

2

1

5

6

7
8
9

3

4
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5 Click “OK”.

One projector can be assigned to one group at a time.

To remove projectors belonging to groups from the group

1 Select “Group Setting...” from the “Control Option” menu.
w The “Group Setting” window opens.

2 Select Group No. by clicking \ / |.

3 Select the projector in the list of projectors belonging to
the group.

4 Click the left arrow button.
The selected projector is removed from the list of projectors belonging
to the group.

To remove all the projectors belonging to a group, click the “Reset” button
after selecting the group number in step 2.

To clear all the projectors belonging to group

1 Select “Group Setting” from the “Control Option” menu.
w The “Group Setting” window opens.

2 Select Group No. by clicking \ / |.

3 Click the “Reset” button.

4 Delete the group name displayed in the Group Name input
section.

5 Click “OK”.
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Password Setting

Setting the Password

1 From the “Control Option” menu, select the “Password”.
The “Set Projector Password” dialogue box will open.

2 Enter 4-digit password using keyboard into the “New
Password” on the “Set Projector Password” dialogue box.
When using the Multiple Projector Operation Mode, select the “ID
number” or “COM port number” before performing the above
operation.

3 Enter 4 digit password using keyboard into the
“Reconfirm” on the “Set Projector Password” dialogue
box.
Check the “Save Password” check box if you want to save the password.

4 Click “OK” .

After setting the password, be sure to write it down in a secure location
so as not to forget it.
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Changing the Password

1 From the “Control Option” menu, select the “Password”.

2 Enter 4-digit old password using keyboard into the “Old
Password” on the “Set Projector Password” dialogue box.
When using the Multiple Projector Operation Mode, select the “ID
number” or “COM port number” before performing the above operation.

3 Enter 4-digit new password using keyboard into the “New
Password” and “Reconfirm” on the “Set Projector
Password” dialogue box.
Check the “Save Password” check box if you want to save the password.

4 Click “OK” .

The password setting is canceled if “OK” is clicked when nothing is
input into the “New Password” and “Reconfirm” area.
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Selecting the Keylock Level

This function can be used to lock the use of certain operation on the
projector.

1 From the “Control Option” menu, select the “Keylock
Level”.
w The “Keylock Level” window will open.

2 Select the Keylock level from “Normal”,”Level A” or
“Level B”.
When using the Multiple Projector Operation Mode, select the “ID
number” or “COM Port number” before performing the above
operation.
See the diagram below about the description of Keylock Levels.

3 Click “OK” button.

Description of Keylock Levels

� The projector can still be fully operated with either the remote or
this software while using the Keylock function.

� If a password is set, the “Keylock Level” setting will only work if
the proper password is input.

Selected item Description

Normal

Level A

Level B

All operation buttons are functional.

Only INPUT, VOLUME, MUTE, BLACK SCREEN on
the projector are available.

All operation buttons on the projector are unavailable.
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Projector Name and Unique Name setting

Names can be given to multiple connected projectors using IDs here.
When giving names, it is possible to select “Unique Name” with a
password or “Projector Name” without a password.

1 Select “Projector/Unique Name...” from the “Control
Option” menu.
w The “Projector Name & Unique Name” Window will open.

1 Select the ID number/COM Port number.
2 Projector Name Input area

12 characters can be input at maximum.
If already set, the set projector name is displayed.

3 Unique Name Input area
12 characters can be input at maximum.
If already set, that unique name is displayed.

2 Select Projector ID by clicking "

3 Input the new name in the Projector Name or Unique Name
column.

� The “Projector Name” is a name for facilitating identification of the
individual projectors when controlling multiple projectors.  We
recommend inputting the projector’s model name, the place where it
is installed, etc., at “Projector Name”.

� The “Unique Name” does not actually affect projector control.  It is
protected by the password set on page 32.  (Only those who know
the password can change it.)
We recommend inputting the name of the projector’s owner, etc., at
“Unique Name”.

1

2

3
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4

1
2

3

E-mail sending function

This software is equipped with a function for sending mail messages to
the address registered when errors occur on the Projector.
The PC setting for E-mail (e.g., LAN connection setting or Dial-up
connection setting) at first is needed to use this function.

Mail Address Book setting

1 Select “Mail Address Book” from the “Control Option” menu.

1 Enable/disable check box
2 Sending mail address input area

2 Input the mail address to which the mail messages are to
be sent.

3 Check the enable/disable check box.

Send Mail Setting

1 Mail server address input area
2 Sender mail address input area

1 2
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3 Mail Send Timing
Error Occurrence:  Send mail immediately when errors occur.
Optional Timing:  Send mail periodically.
Not Send Mail:  Do not send mail even when errors occur.

4 When “Optional Timing” is selected, select the type of
projector information to be sent.

1 Input the mail server address.

2 Input the sender mail address.

3 Make the “Mail Send Timing” setting.
� If you do not want mail to be sent automatically, select “Not Send

Mail”.
� If you do want mail to be sent automatically, select “Error

Occurrence”.
� When “Error Occurrence” is selected, mail is sent when errors

occur on the projector side.

� If “Optional Timing” is checked when “Error Occurrence” is
selected in step 3 above, projector condition data is sent
periodically even if no errors have occurred.

Mail Send Timing
� Select every other day, every other week, every other two weeks or

every other month as the timing at which mail is to be sent.
� When “1 day” is selected, mail is received from the projector every

other day at 10:00 AM.
� When “1 week” or “2 week” is selected, select the day of the week on

which mail is to be sent.
� When “1 month” is selected, select the day of the month on which

mail is to be sent.

About the “Condition” check box
Temp: Send data on whether or not the internal temperature is normal.

Fan: Send data on whether or not the cooling fan is normal.

Filter Cover: Send data on whether or not the filter cover is normal.

Lamp: Send information on the accumulated lamp usage time.

No Response: Send data on whether or not communications with the
projector are normal.

Control Setting: Set the projector user setting values (“Contrast”, “Input
Select”, etc.)  (The user setting values are the same
as the values that can be acquired with the “Save
Control Setting” function on page 48.)
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Error notification function

This software is equipped with a function for automatically notifying the
error information when an error arises with the projector.

If a major error arises, a Warning Window is displayed, as shown below.

When the “Help” button is pressed here, the “Help” window opens.

If the e-mail address is pre-registered at “Send Mail Setting” (page 36),
the projector information is notified when problems arise or periodically.
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Projector Timer Control

This is a function for turning off the projector’s power at the preset time.

� This function can only be used when this software is running on a
personal computer.

� This function manages the time based on the computer’s built-in clock,
so it will not operate properly if the computer’s clock setting is incorrect.

1 Select “Projector Timer Control” from “Control Option”.

1 Select the projector.
2 Enable/disable check box
3 Set the timer off time.

2 Select the projector to be used with the timer off function.

3 Set the timer off time.

4 To enable the timer function, check the check box.

5 Press the “Apply” button.

1

2

3
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Controlling the Projector’s Adjustment

Network Control

This function enables you to control the individual projector adjustments
from your PC.
Refer to the projector’s operation manual for details on each adjustment.

Adjustment Sheet Page

Auto Sync
Black Screen
Freeze
Input Select
Lens
Power
Input1/2/3 Gamma
Input4/5/6 Gamma
Input1/2/3 PICT
Input1/2 Progressive Mode
Input1/2/3 Resize
Input1/2 Signal Type
Auto Sync Display
Auto Sync Setup
Input Adjust
Settings
Special Modes
Input4/5/6 PICT
Input4/5/6 Progressive Mode
Input4/5/6 Resize
Input4/5/6 Signal Type
Audio Adjust
Mute
Volume
Auto Power Off
Background Image
Black Screen Display
ID No. Display
Set Inputs
Lamp Mode
OSD Display
PRJ Mode
Startup Image
3D DNR
Video System

Set Up

Input1 PICT/Input2
PICT/Input3 PICT/

Fine Sync

Input4 PICT/Input5
PICT/Input6 PICT

Audio

Options

42

43

44

43

45

46
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� Adjustments can still be made from the Network Control utility
regardless of the difference in settings in the projector’s menu.

� If you move to Network Control during Presentation Transfer,
Capture & Transfer or Gamma Correction, Sharp Advanced
Presentation Software Professional Edition automatically confirms
the adjustments on the projector and shows them in the Network
Control window as default settings.

� Also when you change the sheet of the Network Control window to
proceed to the other projector adjustment, this confirmation is
performed. In this case, it will repeat at regular intervals afterwards
and the Network Control window may show the settings on the
projector.

� The Automatic Power Shutoff function will not operate when
performing Network Control, although you turn “Auto Power Off”
ON in the “Options” sheet. This function operates during
Presentation Transfer, Capture & Transfer, or Gamma Correction.

Before Adjusting
Serial (RS-232C) cable communications is available for this mode.
Please connect a serial cable to the projector and the PC (page 8),
select the correct COM Port on the PC, then proceed with Network
Control.

Multiple connections

1 Select the individual or group projector on the Multiple
Operation Panel.

2 Click “Jump” on the Multiple Operation Panel.
w The “Multiple Control” window will open.

3 Click the tab of the sheet including your desired
adjustment controller.

Single Connections

1 Select the “Single Control” mode.
See section “Opening Modes” (page 19).
w The “Single Control” window will open.

2 Click the tab of the sheet including your desired
adjustment controller.
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“Set Up” Adjustment

1 Select the “Power” ON/OFF.
2 Select the “Input Select”.
3 To make “Input1/2/3 Gamma” select
4 To make “Input4/5/6 Gamma” select
5 To make “Focus” adjustments
6 To make “Keystone” adjustments

Slide the bar to the desired location or simply type in the desired
value in the box.

7 To make “Digital Shift” adjustments
8 To make “Zoom” adjustments
9 To make “Lens Shift” adjustments
0 Select the “Black Screen” ON/OFF.
q To start “Auto Sync”

Press the “Auto Sync” button.
w Select the “Freeze” ON/OFF.
e To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

r To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

t A “NOW TRANSMITTING...” message is displayed during
transmission.

1

2

3

4

0q we

5

6

7

8

9
t

r
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“Input1/2/3/4/5/6 PICT” Adjustment

� For “Input1/2 PICT” adjustment, “Color”, “Tint” and “Sharp”
adjustments are available for component input signal only. (“Sharp”
adjusts DVD 480i signal only.)

� For “Input3 PICT” adjustment, only “Input3 Resize” can be used
with digital signal inputs.

1 to 8: Slide the bar to the desired location or simply type in the
desired value in the box.

1 To make “Contrast” adjustment
2 To make “Bright” adjustment
3 To make “Red” adjustment
4 To make “Blue” adjustment
5 To make “Color Temp” adjustment
6 To make “Color” adjustment
7 To make “Tint” adjustment
8 To make “Sharp” adjustment

9 To reset the adjustments 1 to 8
Press the “Reset” button.

0 To make “Signal Type” select.
q To make “Resize” select

Select a size mode from the pull down menu. It will change the
pixel composition to resize the picture on the screen.

w To select “Progressive Mode”
e To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

r To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

t A “NOW TRANSMITTING...” message is displayed during
transmission.

1
2
3
4
5

0

q

e r

6
7
8

9

w

t
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“Fine Sync” Adjustment

“Fine Sync” adjustment is not necessary except “Auto Sync Setup”
and “Special Modes” with Input3 (DVI) mode (The “Input Adjust” and
“Settings” items cannot be adjusted.).

1 to 4: Slide the bar to the desired location or simply type in the desired
value in the box.

1 To make “Clock” adjustment
2 To make “Phase” adjustment
3 To make “H-POS” adjustment
4 To make “V-POS” adjustment

5 To reset all the adjustments 1 to 4
Press the “Reset” button.

6 Select the “Auto Sync Setup” ON/OFF.
“ON” is for “Auto Sync” whenever the projector is powered or the
input signal is changed.

7 To select the “Special Modes”
8 To make “Auto Sync Display” ON/OFF.

 “ON” is for displaying Background Image during “Auto Sync”.
9 To store up to seven adjustment settings for use with various computers

Connect a PC to the projector and make the adjustments in “Input
Adjust”. And then press one of the “Save No.” buttons to save the
adjustment setting.

� Make a note of the “Save No.” and its stored setting, if necessary.
You cannot check each setting with this software after saving it.

� The previous setting will be overwritten if you save on the same “Save
No.” button.

0 To select the desired adjustment setting for the currently connected PC
Press the desired “Select No.” button.

Refer to e, r, t on page 43 about the function of q, w, e on this
page.

1
2
3
4
5

q w

9

0

e

6

7

8
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“Audio” Adjustment

1, 2, 3 and 5: Slide the bar to the desired location or simply type in
the desired value in the box.

1 To make “Balance” adjustment
2 To make “Treble” adjustment
3 To make “Bass” adjustment

4 To reset the adjustments 1, 2 and 3
Press the “Reset” button.

5 To make “Volume” adjustment
6 Select the “Mute” ON/OFF.
7 To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

8 To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

9 A “NOW TRANSMITTING...” message is displayed during
transmission.

7 8

5

6

9

1

2

3

4
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“Options” Adjustment

1 to 3 and 8: Select ON/OFF.

1 To make “Black Screen Display” ON/OFF
“ON” is for displaying “BLACK SCREEN”.

2 To make “3D DNR” ON/OFF
3 To make “Auto Power Off” (Automatic Power Shutoff) ON/OFF

The Automatic Power Shutoff function will not operate when
performing Network Control, although you set it “ON”.This
function operates during Presentation Transfer, Capture &
Transfer, or Gamma Correction.

4 See the next page

5 to 7, 9 to w: Select a mode from the pull down menu.

5 To make “OSD Display” select
6 To make “Lamp Mode” select
7 To make “PRJ Mode” select
8 To make “Set Inputs” ON/OFF from Input1 to 6
9 To make “Startup Image” select
0 To make “Video System” select
q To make “Background Image” select
w To make “ID No. Display” select
e To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

r To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

t A “NOW TRANSMITTING...” message is displayed during
transmission.

1

2

3

0q w e r

5

6

7

8

4
9
t
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4 Press the “Get Information” (Lamp & Signal information) button
to open the “Information” window.

“Model”
Shows the model number of the projector.

“Power Status”
On: The power is on.
Off: The power is off.
Cooling: The power is off with the cooling fan turning. Do not

disconnect the power cord during “Cooling”.
“Lamp Status”

On: The lamp is on.
Off: The lamp is off.
Retry: Retrying to turn on the lamp.
Wait: The lamp is on standby.

“Lamp Timer”
Shows the accumulated lamp usage time. It will be reset when
replacing the lamp.

“Trouble Status”
Temp.: The internal temperature is abnormally high. Something

may block air intake.
Fan: The filter cover is open. Securely install the filter cover.
Lamp: The lamp has a problem.
Normal: Displayed in the normal operating condition.

“Real Resolution”
Shows the resolution of the projector’s panel.

“Input Status”
Input1/Input2/Input3/Input4/Input5/Input6

“Resolution” (Displayed for Input1/2/3)
Shows the resolution of the image when projected on the screen.

“Hor Freq” (Displayed for Input1/2/3)
Shows the horizontal frequency (kHz).

“Vert Freq” (Displayed for Input1/2/3)
Shows the vertical frequency (Hz).

“Video System” (Displayed for Input 4/5)
Shows the video input system (NTSC or PAL etc.). The “---” will be
displayed when it is a monochrome or there is no signal. For a
forced system, a “*” will lead the system name.
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Save Control Setting and Load Control Setting

You can save all the current Network Control settings of the projector
in your PC (Save Control Setting) and also load the Network Control
values saved in the PC to the projector (Load Control Setting).

To make “Save Control Setting”
Click the “File” menu to select “Save Control Setting”.
All the current Network Control settings of the projector will be saved
in the SAPS folder on the PC.

To make “Load Control Setting”
Click the “File” menu to select “Load Control Setting”.
The Network Control values will be loaded to the connected projector.

� You cannot use this function when “XGNV1-5” is selected in
“Projector” dialogue box.

� The projector must be identical for the “Save Control Setting” and
“Load Control Setting”.
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Video Wall Setting

With this software, the image of the connected projectors can be divided
from 2 × 2 to up to 8 × 8 to create a video wall.

This function can not be available when the UXGA signal is displayed.

1 Click “Video Wall Setting” from the “Mode” menu.
You can also select “Video Wall” by clicking the  icon.
w The “Video Wall Setting” window will open.

1 Area assigned to the selected projector
2 Select “Division” from 2 × 2, 3 × 3, 4 × 4, 5 × 5, 6 × 6, 7 × 7, 8 × 8,

4 × 3 (Wide screen) or 8 × 6 (Wide screen).
3 Select “Group Name”.
4 Projector selection area
5 Assign the projector.
6 Adjust: The position of the assigned projector can be adjusted in

the horizontal (H) and vertical (V) directions by clicking ', ", \
and |.

2 Select the group.

3 Select “Division”.

4 Select the position to assign at “Position Assignment”.

For the relationship between the position assigned here and the
actual position of the projector, see “Projector image assignment
with the Video Wall Setting” on the following page.

5 Select the projector at 44444.

6 Press the “Assign” button.
The projector is assigned as a video wall component.
To fine-adjust the vertical and horizontal position, click ', ", \ and
| at “Adjust”.

1

6

3

2

4

5
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To reset the current assignment settings
Click “Reset” after selecting the group.

The projector forming a video wall must be belong to a group. To assign
a projector not belonging to a group, add the projector to one of the
groups. (See page 30.)

Projector image assignment with the Video Wall Setting
The projector image assignment for front projection and rear projection
is as shown below.

Front projection

1

1

4

7

2

5

8

3

6

9

4

7

5

8

6

9

2 3

1 to 9 correspond to position numbers on the Screen.

Rear projection
1

1

4

7

2

5

8

3

6

9

4

7

2

5

8

3

6

9

1 to 9 correspond to position numbers on the Screen.
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Adjusting Images

Gamma Correction

Changing the gamma value adjusts the tone of an image on the screen.

This function can only be available in the “Single Projector Operation
Mode”.

Before Adjusting
� Use the projector’s Gamma button and set the CUSTOM mode.
� Infrared communications (IrCOM) cannot be used when performing

gamma correction. Please connect a serial cable or LAN cable to the
projector and the PC (page 8), then proceed to Gamma Correction.

1 Select the “Gamma Correction” mode.
See section “Opening Modes” (page 19).
w The “Gamma Correction” window opens.

1

2

3

4

5

6

7

1 Specify the source of the image. The default setting is
“COMPUTER”

2 The default gamma value is “CUSTOM”, by which you can adjust
the values of the colours in box 3.

The other modes use preset values and you cannot adjust colours
independently in these modes.
“MOVIE”: Emphasizes colour saturation of the entire image.
“FAMILY”: Emphasizes colour saturation of flesh tones.
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“SNOW”: Emphasizes white colour in an image.
“NIGHT”: Emphasizes dark scenes or colours in an image.

3 When “CUSTOM” is selected in box 2, each of these colours
except “WHITE” can be adjusted respectively. As you adjust
“WHITE”, the values of the other three colours will be offset.

The “Reset & Transmit” button resets the values of the colour
currently selected. If you want to reset both the red and green
values, click the “Reset & Transmit” button in the “RED” mode,
and then click the “Reset & Transmit” button again in the
“GREEN” mode. If you want to reset to the original values, click
the “Reset & Transmit” button in the “WHITE” mode.

4 To send all the adjustment signals to the projector
5 To restore to the previous status after operating the gamma data.
6 To restore the status before the “UNDO” button was clicked.
7 Gamma coordinate display (INPUT/OUTPUT)

2 Select the “InputMode”.

3 Select “CUSTOM” or one of the other modes.
w When selecting the “MOVIE”, “FAMILY”, “SNOW”, or  “NIGHT”

mode, the “NOW TRANSMITTING...” message is displayed
during transmission.

4 When selecting “CUSTOM”, adjust the values of each
colour.
Drag and drop the curve of the graph to adjust it to the proper value.

5 Click “Transmit”.
w The “NOW TRANSMITTING...” message is displayed during

transmission.
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Adjusting the GAMMA curve

1 Repeat steps 1-4 of “Gamma Correction”.

2 Place the mouse pointer over the gamma curve.

The mouse pointer takes the shape of an open hand.

3 Drag the gamma curve.

The mouse pointer takes the shape of a closed hand and the curve
changes.
The same operation is possible using the up and down arrow keys
on the keyboard.

Setting the gamma correction area
You can set the gamma correction area by using Drag and Drop. The
gamma curve and mouse pointer moves within the set range after setting
the gamma correction area.
The gamma correction area can also be set by using the right and left
arrow keys on the keyboard while pressing the shift key.

1 Drag the mouse pointer, then drop it.
The point at which the mouse pointer is released is set as the
correction area.
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2 Drag and drop the gamma curve.
Gamma curve or mouse pointer moves within the set range.

� To restore to the previous status after operating the gamma data,
click the “UNDO” button.

� To restore to the status before the “UNDO” button was clicked, click
the “REDO” button.

Saving the gamma correction settings

1 Select “File”, then select “Save GAMMA Data”.
w This opens the “Save As” dialogue box.

2 Specify a “File name”.

3 Specify a “Save In” location.

4 Click “Save”.
The current gamma correction settings of the projector will be saved.

Loading the gamma correction settings

1 Select “File”, then select “Load GAMMA Data”.
w This opens the “Open” dialogue box.

2 Specify a file location in “Look in”.

3 Specify a “File name”.

4 Specify a “Files of type”.

5 Click “Open”.
The gamma correction values will be loaded to the connected
projector.
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Transferring Im
ages

Setup for Transferring Images

Changing Compression Rate

When transferring a BMP image file by Presentation Transfer or
Capture & Transfer, you can change compression rates.

This mode cannot be used with the XG-V10W.

Compression rate
� The default setting for image quality is “middle”.
� If you are transmitting the custom Image (BMP) used as Startup Image

and Background Image, the image is automatically transmitted as
“High quality, slow transmission” for best results. The BMP file will be
transferred without any conversion to minimize the loss of image quality.

� If adjusted, the compression rate will be saved in each image folder
as a file. And the converted files remain in the folder so that the
conversion time can be shortened thereafter.

1 Click the “Option” menu, select “Compression Rate...”.

Better image quality
but slower transmission

Faster transmission
but poorer image
quality

2 Drag and drop the pointer to the rate position you desire.

3 Click “OK”.
w The compression rate in the selected folder will be changed.
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Transferring Images

Presentation Transfer

This mode makes it possible to transfer images saved as BMP or JPEG
files to the projector. A preview of the slides in the file folder selected is
displayed on the PC monitor.

� The XG-V10W does not support JPEG image transfer.
� This function can only be available in the “Single Projector Operation

Mode”.
� If you use the NV-5/6/7, infrared communications can be available.

Before Presentation
� Save the slides as BMP files. The image size must be 1280 × 1024

or lower.

1 Select the “Presentation Transfer” mode.
See section “Opening Modes” (page 19).
w The “Presentation Transfer” window will open.

1 5

4

6

3

2

1 Images in the selected folder (step 3)
2 Information of the selected image
3 Selecting the type of “Transfer Mode” (step 4)
4 Selecting the Presentation Method
5 Starts the “Self Run” transfer (page 59).
6 “Send Image” Transfer (page 58).
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Transferring Im
ages

2 Click the “File” menu, and select “Open...”.
w The “Browse for Folder” window will open.

3 Select the folder in which the image files (Presentation
Slides) are saved. And click “OK”.
w The images in the selected folder are previewed in the

“Presentation Transfer” window.

If the size of image does not fill the box (800 × 500), the image will
be displayed with black space. However, the software will transfer
the image at the original resolution.

4 Select “Image Transfer” in “Transfer Mode”.

For details of the “Custom Image Transfer”, see page 63.

5 On the projector side, the screen is automatically set to
the Custom mode.
To restore to the previous screen, (INPUT1~6) press input selector
key INPUT/select button.

� For NV5/6/7 users:
The projector must be in IrCOM mode to receive the images.
Press the “IrCOM” button on the projector or the remote control.

� For the “Self Run” transfer, skip over here to section “To send all
the images (“Self Run”)” on page 59.
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To send a single image (“Send Image”)
1 Select an image in the “Presentation Transfer” window

to transfer.
If you want to change the compression rate, see the section
“Changing Compression Rate” (page 55).

� The compression rate is applied to all the images in the selected folder.
� Changing the compression rate will change the image picture

quality and transfer speed.

2 Click the “Current” button in the “Send Image” box.
w The “Transmitted File Information” dialogue box appears and

the transfer begins. If you want to stop the transfer, click “CANCEL”.

w To send the next image, click the “Next>” button in the “Send Image”
box.

w To send the previous image, click the “<Previous” button in the
“Send Image” box.

w The default order of images follows the file name.
You can change the order of the image files by dragging and dropping
them to the desired location.
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To send all the images (“Self Run”)

1 Select the desired method in “Self Run”.
“Continuous” sends all images in the specified folder endlessly.
“Once” sends all images in the specified folder once.

2 Select the interval to send images in “Self Run”.
You can select it in the range from 30 seconds to 5 minutes fixed in
units of 15 seconds.

3 After step 4 on page 57, press the “Start” button in the
“Self Run” box of the “Presentation Transfer” window.

w The “Transmitted File Information” dialogue box will appear and
the transfer will begin. If you want to stop the transfer, click “Skip”.

w After the transfer is completed, the “Slide wait” dialogue box will
appear until the image will be projected on the screen. If you want to
cancel the interval and soon show the next image, click “Next>>”.

w To cancel Self Run, click “Exit”.
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Capture & Transfer

This mode allows you to transfer an image of what is currently displayed
on the PC monitor.

� This mode can only be available in the “Single Projector Operation
Mode”.

� If you use the NV-5/6/7, infrared communications can be available.

Before Presentation
� This function is not available for full screen slides (e.g. the “Slide

Show” mode of Microsoft PowerPoint).
For full screen slides to use Capture & Transfer, see the section
“Quick Transfer” (page 62).

1 Display the image you want to transfer.

2 Select the “Capture & Transfer” mode.
See section “Opening Modes” (page 19).
w The “Capture & Transfer” window will open.

Selecting the type of 
“Transfer Mode” (step 3)

3 Select “Image Transfer” in “Transfer Mode”.
If you want to change the compression rate, see the section
“Changing Compression Rate” (page 55).

� For the details of the “Custom Image Transfer”, see page 63.
� Changing the compression rate will change the image picture

quality and transfer speed.
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On the projector side, the screen is automatically set to the CUSTOM
mode.

For NV5/6/7 users:
The projector must be in IrCOM mode to receive the images. Press the
“IrCOM” button on the projector or the remote control.

4 Click the “Capture & Transfer” button in the “Capture &
Transfer” window.
w The “Capture & Transfer” window disappears and capturing

begins.
w After capturing is completed, the “Capture & Transfer” window

reappears and transfer of the captured image begins.
w The “Transmitted File Information” dialogue box appears.

If you want to stop the transfer, click “CANCEL”.

To send another image
Change the displayed image on the PC monitor and then repeat step 4.
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Quick Transfer

Applying the preset compression rate, this mode allows you to transfer
images by simple steps.

� This mode cannot be used with the XG-V10W.
� This mode transfers images under the following settings which cannot

be modified.
• Normal picture quality
• Compression rate: Middle

The custom image used as Startup Image and Background Image
cannot be transferred by this mode.

Before Presentation
� Confirm that the “Auto-Launch” setting is “ON” (page 21) or the

software is active.
� This function is available for full screen slides (e.g. the “Slide Show”

mode of Microsoft PowerPoint).

1 Display the image you want to transfer.

2 Keep the right mouse button depressed for 2 seconds.
The position of the pointer can be anywhere on the display.
w The “Quick Transfer” window opens.

On the projector side, the screen is automatically set to the custom mode.

For NV5/6/7 users:
The projector must be in IrCOM mode to receive the images. Press the
“IrCOM” button on the projector or the remote control.

3 Click the “Capture & Transfer” button in the “Quick
Transfer” window.
w The capturing begins.
w The “Transmitted File Information” dialogue box appears and

the transfer of the captured image begins.
If you want to stop the transfer, click “CANCEL”.

w After the transfer is completed, the “Transmitted File
Information” dialogue box disappears.

4 Click “EXIT” in the “Quick Transfer” window.

To send another image
Change the displayed image on the PC monitor and repeat from step 2.
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Saving a Custom Image as Startup Image and Background Image

The projector has an option to display a custom image (e.g. your company
logo) upon startup of the projector (Startup Image) or when there is no
signal (Background Image).
You can choose your custom image from the projector’s mode menu.
Refer to the projector’s operation manual for how to set Startup Image
and Background Image.
The following is the procedure for saving the custom image on the
projector.

� The custom image used as Startup Image and Background Image
must be a 1280 × 1024 or lower sized 256 colour BMP file.

� If the pallet uses over 240 colors with 256 colour BMP files, the image
is automatically converted within the projector’s number of colour
limits.

� 24-bit colour BMP files are converted into 256 colors.
� Selecting and leading the custom image file as Startup Image and

Background Image can be done by Presentation Transfer or
Capture & Transfer.

Select “Custom Image Transfer” in “Transfer Mode” of the
“Presentation Transfer” window or of the “Capture & Transfer”
window.
Refer to “Transferring Images” (page 56) for how to transfer the image.

The “Custom Image Transfer” mode saves one image file only
and overwrites the previously transferred image if you send another
image file.
To avoid erasing the custom image, you should change the transfer
mode to “Image Transfer” after sending the custom image.

S
aving a C

ustom
Im

age
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Troubleshooting

Unable to transfer images or an error occurs with communication

H Check that the connection type is surely selected as you intend.

H Check that the image size is 1280 × 1024 or lower.

In case of cable communications (RS-232C and LAN)
H Check whether the transmission speed set at “Projector Setting”or

“Scan Setting” is the same as the transmission speed set at
“RS-232C” on the projector’s OSD menu.

H Check that the port for the RS-232C serial cable or LAN cable is
correctly specified in the PC’s settings.

H Check that the cable is correctly and securely connected (page 9).

In case of infrared communications (IrCOM)
H Check that the infrared ports (the projector and the PC) are within

1 meter (3 ft.) distance and keep the vertical and horizontal range
within 30 degrees.

H Check that there are no obstacles between the projector and the PC.

H Avoid using this function under strong lighting conditions.
Strong light sources such as sunlight or fluorescent lighting may
interfere with image transmissions.

H Check that the projector is in the IrCOM mode before transferring
images from the PC. (See the projector operation manual.)
The On-screen Display “IrCOM stand by” or “IrCOM stand by
Waiting for Data” will appear on the projection screen.

H Check that your PC’s IrDA port is activated and configured properly.
Check the PC’s  instruction manual.

H Check that “Connection Type” in Single Projector Setting (page 27).

H Confirm that the port for infrared communications is correctly specified
in the PC’s settings.

H For Windows 95 users: Check that Microsoft’s IrDA 2.0 (Infrared
Driver) is installed (page 7).

H Check that the display mode is appropriate for  the images. (Normal
transfer: 24 bit colour or less; “startup Image” transfer: 256 colours
for BMP files)

H Infrared communications (IrCOM) cannot be used with Windows NT.
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“Gamma Correction”/“Network Control” is not operating properly

H Reconnect the RS-232C serial cable or LAN cable and try again.
The cable may not be connected properly or an error may have
occurred during the transmission.

H Check that the port for serial (RS-232C) communications is correctly
specified in the PC’s settings (page 24).

H Projector may not be receiving command because of the projector’s
setting. Please check the projector’s “ON/OFF” status, “INPUT
SELECT” status (COMPUTER, VIDEO) or the input signal. Resend
the command after adjusting these items.

H Before Gamma Correction, use the projector’s Gamma button and
set the CUSTOM mode.

The transmitting speed is low

H Do not use the projector’s remote control while transferring.

H Check the compression rate setting (page 55).

H Check the Transmission Speed setting, in the case of RS-232C cable
communications (page 25).

H Note that custom image as Startup Image and Background Image
is fixed in the “High quality, slow transmission” setting.

H Note that Quick Transfer is fixed in the “Normal quality, middle
speed” setting.

H Check that your PC supports IrDA 1.1.

H Check the transmitting speed from your PC.
If the speed is 4 Mbps, check that an IrDA 1.1 driver is installed
(page 7). Refer to the PC’s instruction manual.

If 4 Mbps IrDA should fail

H If 4 Mbps IrDA should fail, try transmitting at 115 kbps. The following
is the procedure to change the transmitting speed.
1) Click the Windows “Start” button and then select “Settings”.
2) Select “Control Panel”.
3) Double click the “Infrared Monitor” icon.
4) Click the “Options” tab.
5) Select “Limit connection speed to” and change it to 115kbps.
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Unable to save the startup image

H Do not turn off the projector while transmission.
The image data may be lost.

Quality of the image is low

H Check the compression rate setting (page 55).

H Note that Quick Transfer is fixed in the “Normal quality, middle
speed” setting.

Unable to speed up the transfer or improve the image quality

H If the image file is saved in JPEG format, its compression rate cannot
be changed.
Note that the compression rate only applies to BMP file format.

Unable to speed up “Gamma Correction” though the
transmitting speed was changed

H The transmitting speed setting applies to image transfer via cable
only. The speed for transfer of gamma values is fixed at 9,600 bps.



67

G
lo

ssary/
S

ervices

V10W

Single
Multi

No ID ID

P10X, C30X

Single Multi

NV5-7

Single Multi

NV1-4

Single Multi

Serial(RS-232C)

IrCOM(IrDA)

LAN

Network Control
Gamma Correction
Presentation
Network Control
Gamma Correction
Presentation
Network Control
Gamma Correction
Presentation

× × ×
× - -
× - -
- - -
- - -
- - -
- - ×*1

- - -
- - -

× ×
× -
× -
- -
- -
- -
- -
- -
- -

× ×
× -
× -
- -
- -
× -
- -
- -
- -

× ×
- -
- -
- -
- -
- -
- -
- -
- -

*1: with Optional Expansion Board

× × ×
× × ×
× × ×
- - ×
× × ×
× × ×
× × ×
× × ×
× × ×

× - -
× - -
× - -
× - -
- × ×
- - ×

× × ×
- - -

- × ×
× × ×
× × ×
× × ×
- - ×
- × ×
- × ×
- × ×
- × ×

× ×
× ×
× ×
- -
× ×
× ×
× ×
× ×
× ×

× -
× -
× -
× -
- ×
- -

× ×
× ×

- ×
× ×
× ×
- -
- -
- ×
- ×
- ×
- ×

× ×
× ×
× ×
- -
× ×
× ×
× ×
× ×
× ×

× -
× -
× -
× -
- ×
- -

× ×
× ×

- ×
- -
- -
- -
- -
- ×
- ×
- ×
- ×

× ×
× ×
× ×
- -
× ×
× ×
- -
- -
× ×

- -
- -
- -
× -
- ×
- -

× ×
- -

- ×
- -
- -
- -
- -
- ×
- ×
- ×
- ×

MENU V10W P10X, C30X NV5-7 NV1-4

Table of Functions by Model

The table below shows the available function for other projector.
× : Signifies available function

- : Signifies unavailable function

*ID setting can be available for V10W only

File
Open
Operation Mode Setting
Projector Setting
Scan Setting
Save Control Setting
Load Control Setting
Save Gamma Data
Load Gamma Data
Exit

Mode
Capture & Transfer
Presentation Transfer
Gamma Correction
Single Control
Multiple Control
Video Wall Setting

Option
Auto-Launch ON / OFF
Compression Rate

Control Option
Projector Timer Control
Password
Keylock Level
Projector / Unique Name
Group Setting
Mail Address Book
Send Mail Setting
Error Log Viewer
Configuration
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22

21

28

63

2

60

8

55

63

63

53

38

22

22

51

51

30

22

8

23

56

23

23

7

7

7

2

Glossary

Version information

Specify if this software launches automatically upon startup

Function turning both “Black Screen” and “Mute” on.

Image displayed when no signal is input.With the
XG-V10W, same as startup image.

Image file format

Transfer an image of what is currently displayed on a monitor.

Communication port

Rate of compression of the images transmitted from a
PC to the projector

General term for background image and startup image

Transfer the custom image to the projector. (Unless the custom image is
transferred again (overwritten), the screen is retained in the projector’s memory.)

Select an item and modify it using the mouse.

Browse the log of errors generated in the multiple projector operation mode.

Exit from this software

Main menu item

Projector’s specific values of specified colours

Adjust the projector’s gamma values from PC

Make the settings for controlling groups of projectors in
the multiple operation mode.

Help in using this software

Network concentrator

For specifying the individual projectors when controlling
multiple projectors simultaneously.

Transfer the image to the projector. (Unlike custom image
transfer, not stored in projector.)

Abbreviation of “Internet Protocol”

Address for specifying computer on network.

Sharp infrared wireless communication

Abbreviation of “Infrared Data Association”. Name of infrared
communications standardization group and name of standards

Standard format (protocol) for transmission of images

Abbreviation of “Joint Photographic Experts Group”

About This Software

Auto-Launch ON/OFF

AV Mute

Background Image

BMP

Capture & Transfer

COM

Compression Rate

Custom Image

Custom Image Transfer

Drag & Drop

Error Log Viewer

Exit

File

Gamma

Gamma Correction

Group Setting

Help

Hub

ID

Image Transfer

IP

IP Address

IrCOM

IrDA

IrTran-P

JPEG

Word Explanation Page
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Word Explanation Page

Keylock Level

LAN

Mode

Multiple Control

Multiple Operation Panel

Open

Operation Mode

Option

Password

Presentation Transfer

Projector Name

Projector Setting

Projector & Unique Name

Quick Transfer

RS-232C

Single Control

Scan

Scan Setting

Self Run

Serial Number

Startup Image

Transfer Mode

Transmission Speed

Unique Name

34

8

21

28

28

57

20

21

32

56

35

25

35

62

7

41

23

23

59

23

63

63

23

35

Set whether to enable or disable operating buttons on projector.

Local Area Network

Main menu item

Simultaneous control of multiple projectors from PC.

Operating panel for integrated control of projectors in
multiple projector operation mode.

Open file folder containing images to be transmitted to
the projector(for Presentation Transfer)

Set whether to control a single projector or multiple projectors.

Main menu item

When a password is set, some functions can only be
changed by the person with the password.

Transfer a series of images (BMP or JPEG) to the projector

Names freely given to individual projectors. Unlike “Unique
Name”, can be changed freely by anyone.

Set the method of communication with the projector.

Make and change the “Projector Name” and “Unique Name” settings.

Shortcut to transferring an image of what is currently displayed on a monitor

Serial interface protocol with which many PCs are equipped.

Control a single projector from a PC.

Function for searching for all connecting projectors and
automatically identifying them.

Set the COM port and IP address for searching with the
scan function.

Scan slides in a specified folder one after another to the projector

Serial numbers assigned to individual projectors

Image displayed when projector turned on With the
XG-V10W, same as background image.

Change the function from “Custom image Transfer” and/
or “Image Transfer”

Transmission speed via the projector’s RS-232C port and
PC’s serial port.

Names given to individual projectors. Unlike “Projector
Name”, when the password setting is set, can only be
changed by person with password.
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Services

Please contact nearest Sharp dealer if there are any problems.
For user purchased the projector in following countries, you can contact to the addresses
shown if you have problems.

USA Sharp Electronics Corporation
1-800-BE-SHARP (1-800-237-4277)
Icdsupport@sharplcd.com
http://www.sharp-usa.com/

Canada Sharp Electronics of Canada Ltd.
Sharp Customer Care Center
(905) 568-7140 (Local) or 877-742-7722(toll free)
http://www.sharp.ca

Mexico Sharp Electronics Corporation Mexico Branch
Servicio al cliente llame:
SHARP GENIAL
Respuestas inmediatas
(525) 716-9000

Germany Sharp Electronics (Europe) GMBH
01805-234675
http://www.sharp.de

U.K. Sharp Electronics (U.K.) Ltd.
0161-205-2333

Australia Sharp Corporation of Australia Pty.Ltd.
02-9830-4600
02-9672-1216 (Fax)
http://www.sharp.net.au

Hong Kong Sharp-Roxy (Hong Kong) Ltd.
2822-9303
2528-4879 (Fax)

Singapore Sharp-Roxy Sales (Singapore) Pte., Ltd.
65-4294342
http://www.sharp.com.sg
kwee@global.sharp.co.jp

U.A.E. Sharp Middle East Fze
971-4-81-5311
helpdesk@smef.global.sharp.co.jp

Thailand Sharp Thebnakorn Co., Ltd.
02-236-0170
02-236-9188 (Fax)
http://www.sharp-th.com

Korea Sharp Electronics Incorporated of Korea
(82) 2-3660-2002
(82) 2-3660-2029 (Fax)
http://www.sharp-korea.co.kr
webmaster@sharp-korea.co.kr

Information
You can see information about Sharp Advanced Presentation Software Professional
Edition on the following home page.
http://www.sharp-world.com/projector
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